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Minimum Requirements

Minimum Computer Standards: NOTHIN' BUT THE FACTS: Pre-Algebra
Skills v2.1 can be used on any PC or IBM compatible computer with a minimum
of the following: 486 DX/2, 66MHZ,  6MB RAM, Super VGA Video Card, and a
3.5" Floppy-Disk drive.  It occupies 8 MB of Hard Disk space. The program runs
on Windows 3.1/95/98. To print Certificates of Mastery, an HP Laser-compatible
printer is required. Windows compatible sound card (optional).

Minimum User Skills: The user (student) of this program needs only minimal
computer keyboard and/or mouse skills.  Most commands can be accessed by
pointing and clicking. (See Interface Commands in Appendix C). The program is
user-directed with instructions  provided on-screen for each menu and activity
screen.

User Age: 10  to Adult.

Minimum Math Level:  Preparation for Algebra. Method of solutions and
examples accessible on-screen.
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Features

• Complete review,  practice, and drill program to assist elementary algebra
students in gaining competency and mastery in the basic integer (signed
number) operations.

 
• Math content covering the following algebraic integer skills:

1. opposites
2. absolute values
3. addition
4. subtraction
5. multiplication
6. division
7. combined operations
8. working with parentheses
 

• A Review Activity that emphasizes memorizing the basic operations by
using the mouse to drag and drop.

 
• A Practice Activity that tests accuracy by typing in answers and receiving

immediate feedback.
 
• A Drill Activity that challenges for mastery by offering timed problem sets

of increasing difficulty.
 
• Examples readily available on-screen by a single mouse click.
 
• Unlimited number of  randomly-generated problem sets.
 
• Printed personalized Certificates of Mastery.
 
• Performance reports that summarize total time and problems missed on

the Practice and Drill Activities.
 
• Easy to complex problem types (up to five integers per problem).
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Introduction
Philosophy & Goals
Welcome! Nothin’ but the Facts: Pre-Algebra Skills v2.1 is a program that will
assist you in reviewing, practicing, and mastering the algebraic skills of
opposites, absolute value, and basic operations with integers. It makes use of
the time-proven system of learning these skills by rote and drill via use of the
computer. The computer allows you to quickly access skills for study,  provides a
variety of activities for your interaction and learning, gives you immediate
feedback, keeps track of your progress, and advances you to mastery.

It is the philosophy of IEPMath  to meld the time-proven methods of teaching
mathematics with the stimulating, responsive, and tracking capabilities of
today's computing.  In a search to find methods which are fun and stimulating,
many products today fail because they do not emphasize learning the basic
skills. Instruction through the ages has demonstrated that learning mathematics
involves hours of practice and drilling. NBTF provides an unlimited number of
drill and problem sets within a variety of activities that will stimulate and motivate
you in your pursuit of mastery.

The goals of NBTF are to assist and direct you to:
• Master the basic algebraic skills of integer operations.
• Demonstrate competence in working both mentally and within a set time

period  problems that range from simple to complex.
• Gain confidence and maturity that will enable you to learn more advanced

mathematical concepts with ease.

Who We Are

IEPMath  is an educational software company of teachers and educators whose
goal is to create high quality instructional materials that consist of an interactive,
self-discovery, learn and mastery orientation.  Our purpose is to provide
instructional curriculum that meets the needs of a variety of students, teachers,
parents, schools, and communities in a manner which is comprehensive,
effective, and easy to use.

For further information:  Call (909) 880-0820 or write:
IEPMath
PO BOX 54
Lytle Creek, CA  92358
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Getting to Know You

We at IEPMath are interested in knowing about you.  Please fill out the enclosed
Registration Card (inserted at the back of this manual), and tell us about your
needs and what you think about NOTHIN' BUT THE FACTS!   If you will fill out
and mail to us this pre-stamped and self-addressed card, we will:

• Send you information about our other educational software product
• Send you information regarding new versions of NOTHIN' BUT THE

FACTS! as soon as they are available.
• Provide you with discounts on all of our products.

Program Format

The basic format of NBTF is quick access, simplicity, and ease of use. After
signing in, you may then select one of the three main activities of NBTF.

• Review Activity: You will be provided six, randomly-generated problems.
From the answer box, use the mouse to click, drag, and drop correct
answers to the six problems. Immediate feedback is presented, and you
may attempt each problem an unlimited number of times. A screen of
examples is just a mouse click away!

• Practice Activity: You will be asked to answer problems on six cards that
are flashed to you at random. Immediate feedback is provided as you
work problems until all the cards of the set are answered correctly.

• Drill Activity: For problem sets of ten, you will be asked to demonstrate
competency by answering all the problems correctly within a set period of
time. The objective is to attain mastery of your skill level by progressing
through six of these sets of increasing difficulty.

• Reference: Commonly used integer definitions.

Product Support
Product Support is available to registered users through the Internet and
America Online. You may also call 909-880-0820 and leave a message.

Internet
Email: support@iepmath.com

America Online
Screen Name:  IEPMath
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1. Getting Started

Installing the Program

Step 1:  [Windows 3.1]: In the Program Manager, go to the File menu and select Run.
   [Windows 95 and 98]:  From the START menu, select Run.

Step 2: In the Command Line box, type the letter for your computer's floppy drive,
followed by , :\SETUP.EXE (for example A:\SETUP.EXE)

Step 3: Follow the Setup program instructions.

Starting the Program

[Win 3.1]
1. If the Program Manager window is not open, double-click (left button) the

Program Manager icon.
2. Double-click on the IEPMath icon from the Program Manager.
3. Double-click on the IEPMath Pre-Algebra Skills v2.1 icon to start the

program in the IEPMath Group window.

[Win 95/98]
1. From Desktop, click Start and then Programs.
2. From the Programs menu, find and click the IEPMath directory and then select

IEPMath Pre-Algebra Skills v2.1.

SIGNING IN

The Sign-In  Screen
The Sign-In Screen is where we welcome you to our program and ask that you
type in your name and press <Enter>. You can use up to ten letters in typing
your name.  This will identify you to the computer so that it can communicate to
you throughout the program by name.
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OPTIONS

To access the Options Menu, select OPTIONS from the MAIN MENU or press
the F8 key anywhere within the program.

Sound Settings
If you have a sound card that is configured properly for Microsoft Windows you
have the option of hearing sound in NBTF Pre-Algebra Skills v2.1. Click on the
SOUND EFFECTS checkbox to enable/disable sound.

Selecting Certificate Color
If you have a color printer, you will be able to select different border colors to print out
your Certificates of Mastery. Select a color for either Color #1 or Color #2 and press
the Test button to preview the certificate.

Drill Times
You can change the drill times for each Subject. Drill times are represented in seconds
and can be any value between 1 and 999. To turn the time limit off, simply click on the
checkbox next to the level.

How About a Quick Tour?
Why not take a few quick tours before becoming too immersed in the program?
There are three tours listed in an easy-to-use format in Appendix A of this User's
Guide.  Each is about 5 minutes in length and will give you a good introduction
to the three main activities of this program.
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2. Selecting an Activity

What Are the Activities?

The Main Menu
At this point in the program, you are to choose which of the three main activities
you wish to work on. In learning the basic algebraic operations, it is suggested
that you focus on the skills in the order in which they are presented here. Pre-
Algebra Skills v2.1 is not intended for use as the primary means of instruction.
Please take the time to study any textbook, notes, study guides, assignments,
etc., before working with this software. The purpose of NBTF is to assist you
only in reviewing, practicing, and drilling.

The following is a summary of each activity.  Once you have chosen an activity,
you may refer to the section of this User's Guide that covers that activity for
objectives, study questions, instructions, and study hints.

The Review Activity   
To begin reviewing the skill selected, you will click on the Examples button to
see the solution steps and some worked-out problems. Then you will work out
each problem presented and choose what you think is the correct answer by
using the mouse to click, drag, and drop. Examples are just a mouse-click away!
After answering each of the six problems, click on More for six additional
problems. Problems are randomly generated and no two problem sets are
identical.

The Practice Activity
To begin practicing the skill selected, you will click on the Examples button to
see the solution steps and some worked-out problems. You will gain confidence
and competency in the skill being studied by answering numerous problems
randomly presented for your practice. Upon answering each problem, immediate
feedback is displayed.  If the answer is correct, the problem is placed into the
Mastered Area.  If the answer is incorrect, the problem is placed back into the
Unmastered Area.  It will remain there until it is presented again and answered
correctly. After answering each of the six problems, click on More for six
additional problems. Problems are randomly generated and no two problem sets
are identical.
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The Drill Activity
In the Drill Activity, you will build mastery by challenging yourself to answer
timed problem sets of ten problems with 100% accuracy. If you do not master all
ten problems, you will be presented a brief report of the problems answered
correctly and the problems answered incorrectly (with correct answer); then ten
more problems will be generated and you will be able to try that level again.
Problem sets will continue to be generated until you have answered all ten
problems correctly within the set time limit. Upon mastering a level, you will be
rewarded with a Certificate of Mastery!

Choosing an Activity
To select an Activity from the Main Menu:
Type the first letter of  the word, or click on the button of the Activity that you
wish to choose.

To change to another activity, at any time within the program, click on Main
Menu, and choose another activity.
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3. Choosing a Subject

What Are the Subjects?

The Subject Menu
At this point in the program, you are to choose which algebra skill you wish to
work on. Pre-Algebra Skills v2.1 focuses on each of the following skills within
each activity: (see Appendix B for a quick reference guide)

Opposites & Absolute Values

Absolute Value:  Examples and problems consist of a single integer placed
within a set of absolute value symbols. Skill includes two problem types: no sign
preceding the absolute value symbols and a negative sign preceding the
absolute value symbols.

Identify:  Examples and problems consist of a single integer placed within a set
of parentheses. Skill includes two problem types: no sign preceding the
parentheses and a negative sign preceding the parentheses (opposites).

Combinations:  Problem sets consist of a random selection of problems from
each of the previous two skills sections.

Algebraic Addition of Integers

Same Signs:  Examples and problems consist of  two integers each placed
either outside or within a set of parentheses. The integers are either both
positive or both negative.

Different Signs:  Examples and problems consist of  two integers each placed
either outside or within a set of parentheses. The integers have opposite signs
with respect to each other.

Three Integers: Examples and problems consist of  three integers each placed
either outside or within a set of parentheses.
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Algebraic Subtraction of Integers

Two Integers: Examples and problems consist of two integers each placed
either outside or within a set of parentheses. The integers are separated by a
subtraction sign.

Three Integers: Examples and problems consist of three integers each placed
either outside or within a set of parenthesis. The integers are separated by
addition and/or subtraction signs.

Using Parentheses: Examples and problems consist of the sum or difference of
an integer and the sum or difference of two other integers placed within a set of
parentheses.

Multiplication, Division & Combined Operations

Two Integers: Examples and problems consist of two integers placed either in
adjacent sets of parentheses (indicating multiplication) or in parentheses
separated by a division sign. The integers are of either the same or different
signs.

3 or More: Examples and problems consist of three to five integers placed in
adjacent sets of parentheses (indicating multiplication).

Combined Operations: Examples and problems consist of a combination of the
operations of addition, subtraction, and multiplication.

Choosing a Subject
Click on the name of the algebra skill you wish to study (its button will light up) to
make a selection from the Subject Menu.

To change to another algebra skill, at any time within the program, click on
Subject Menu, and choose another skill.  Please note that when you leave the
Review or Practice Activities, the program does not track your progress. Upon
re-entering either of these activities, you must begin again. However, within the
Drill Activity, the program will track your progress.  If you wish to leave the
activity to perform review, upon your return to the Drill Activity, you will be able
to pick up where you left off.  Please note that when you exit the program, even
within the Drill Activity, the tracking is discontinued.
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4. The REVIEW ACTIVITY
Getting to the Review Activity
From the Main Menu, click on Review or type R. Next, from the Subject Menu,
click on the algebra skill you wish to review.

Overview
In this activity, after studying the examples, for each problem presented in the
Question box, you will be asked to select, click, drag, and drop a number from
the Answer box that you believe is the correct answer. If you are incorrect, the
number will automatically return to its original location in the Answer box, and
you then attempt another number. If the correct number is clicked, dragged, and
dropped, it will be retained as the answer to the problem.

Objectives
After performing the Review Activity for each algebra skill selected, you will
have:

• Memorized the basic steps of solution.
• Demonstrated accuracy in the solving of problems by  providing the

correct answers from a listing of possible answers.
• Determined how a change in sign can affect the outcome when comparing

two similar problems.

Instructions
Upon arriving in the Review Activity,
1. Click on Examples to review methods of solution and examples of problems

of the algebra skill selected. To return to the problems within the activity,
simply press any key. Don't be afraid to click on Examples when you have
the slightest doubt as to methodology.

2. Work out a problem from the Question box.  (It is not necessary to work the
problems in order.)  Use pencil and paper for the more difficult problems.

3. Select a number from the Answer box. Using your mouse, place the arrow
on-screen over the number that you feel correctly answers the problem. Click
with the left mouse button. Without releasing that button, move the number
(by moving your mouse) to a location directly to the right of the problem.
Then release your finger from the left button.
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4. If the answer is incorrect, the number will move, on its own, back to its
original location within the Answer box. Evaluate what you may have done
incorrectly. Rework the problem. Select another number from the Answer box
and try dragging and dropping it to the right of the problem. Keep trying until
you find which of the numbers is that problem's correct answer.

5. If the answer is correct, the number will be retained and not move back to its
original position. Note the reinforcement at the bottom of the screen. Make
note of all the factors that you had to take into account and your correct
solution of that problem.

6. Progress on to other problems until you have answered each of the problems
correctly.

7. Click on More to obtain a new problem set.

Study Questions
The following are questions to help guide you through your learning of the
algebra skills within the Review Activity. For each skill selected, try to answer
these questions:

• What are the symbols (operations signs, parenthesis, vertical bars, etc.)
of the problems of this skill-type that I can recognize when I see them?

• What kinds of problems are contained within this skill level? How do they
differ from one another?

• How do problems of this skill-type differ from problems of other but similar
skill-types?

• What are the steps of solution for problems of this skill-type?
• How do individual sign changes within the problem affect the answer?

Hints
Repeated review facilitates learning--the more problems you do, the better math
student you will be. When you answer a problem, take the time to determine
what you did correctly and what you did wrong.  Learn from your mistakes.  No
one will know but you how many errors you made!  Your simple goal is
improvement.
Take your time.  Relax.  Have Fun!

The More Button
After completing a problem set, you are encouraged to try another problem set
by clicking on More. This will randomly generate another six problems. You are
encouraged to do this for as many times as you wish. No two problem sets will
be the same.
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5. The PRACTICE ACTIVITY

Getting to the Practice Activity
From the Main Menu, click on Practice or type P.  Next, from the Subject Menu,
click on the algebra skill you wish to practice.

Overview
There are two main areas of the Practice Screen--the Unmastered Area and the
Mastered Area.  The activity begins with six problems of the algebra skill that
has been selected located in the Unmastered Area.  Problems are then
presented at random for answering.  Correctly answered problems are placed in
the Mastered Area, and those answered incorrectly are returned to the
Unmastered Area to be randomly selected again.  There are no time limits;
however, the total time it took to complete the problem set will be displayed.

Objectives
After performing the Practice Activity, you will have:

• Determined the correct answers to problems previously answered
incorrectly.

• Learned the method of solution for each algebraic skill area selected.
• Answered problems for each selected skill with 100% accuracy.
• Developed confidence by correctly answering all problems of a problem

set in a time faster than your previous, personal best.
• Demonstrated competency in that skill area by consistently answering

problems correctly within a time period near your personal best.

Instructions
1. Click on Examples to review methods of solution and examples of problems

of the algebra skill selected. To return to the problems within the activity,
simply press any key. Don't be afraid to click on Examples when you have
the slightest doubt as to methodology.

2. Type in the answer to the problem presented.

3. Type <Enter> to see the correct answer and check if you were correct or
incorrect.

4. Type <Enter> to see the next problem.
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5. Work problems until all the cards have been relocated from the Unmastered
Area to the Mastered Area.

6. After completing the problem set, take note at the bottom of the last screen of
the total time it took you to complete the set.

7. Click on More to generate another problem set. Attempt to complete this set
in a faster time than your previous best.

Study Questions
The following are questions to help guide you through your learning of the
algebra skills within the Practice Activity. For each skill selected, try to answer
these questions:

• What is the method of solution for problems of this skill-type?
• What is the order for which the problem is to be solved? Which part of the

problem is to be done first, second, etc.?
• When you answer a problem wrong, how can you learn from it so that you

do not make that same mistake again?
• How quickly can you complete the activity by getting all the cards to the

Mastered Area?

Hints
• As you perform the problems, mentally review the steps for solving this

problem-type.
• Think about how these problems differ from other similar problems; take the

time to determine a strategy for how you will distinguish the difference.
• When you get completely stuck, click on Examples to see the complete

method of solution and examples.
• Don't be afraid to make a mistake.  When you do, determine why you missed

the problem and try not to make the same mistake the next time.

The More Button
After completing a problem set, you are encouraged to try another problem set
by clicking on More. This will randomly generate another six problems. You are
encouraged to do this for as many times as you wish. No two problem sets will
be the same.
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6. The DRILL ACTIVITY

Getting to the Drill Activity
From the Main Menu, click on Drill or type D. Next, from the Subject Menu, click
on the algebra skill you wish to drill.

Overview
You will be presented ten problems (one at a time) that you must answer as
quickly as possible.  If you answer all ten correctly within the time limit, you will
earn a Certificate of Mastery!

Objective
After completing the Drill Activity, you will have demonstrated mastery for that
algebraic subject area by answering all problems correctly within the time limits.

Instructions

1. Note the time limit for each level's problem set.

2. Type <Enter> to begin the set.

3. Type the answers as quickly as possible.

4. If you wish to change an answer, before typing <Enter>, use <Backspace> to
erase the entry.  Retype the answer.

5. After answering, type <Enter> for the next problem.

6. After you have answered the ten problems of each level, you'll be presented
feedback regarding:
• Number of problems answered correctly.
• Time taken for that problem set.
• Whether you need to redo that level.
• Any problem answered incorrectly, your answer, and the correct answer.

7. Type <Enter>  to either redo the current level or progress to the next level.
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8. When you have mastered a level, the Certificate button will appear. If you
wish to print a personalized Certificate of Mastery, make sure that your
printer is turned on and click on Certificate.

Study Questions
The following are questions to help guide you through your learning of the
algebra skills within the Drill Activity. For each subject selected, try to answer
these questions:

• Does performing problems quickly make you more confident and
competent?

• Since it is not important how many times you attempt a problem set, can
you see how by trying over and over again, you gain competency?

• At the end of the problem set, if you missed problems, can you see why
you made your errors? What will you remember about these errors so that
you will not make similar errors again?
 

Hints
• Use the Number keys for quicker answering.
• First step: make note of the signs.
• Work as quickly as possible.
• When answering, double check the sign of the answer.
• If you do not answer all of the problems correctly and/or if you go over the

time limit, simply redo another problem set within that level.
• Keep working; reward yourself for making improvements

Exiting the Drill Activity
If you leave the Drill Activity to review, practice, or try another subject area, upon
returning to the Drill Activity, you will automatically be advanced to the level from
which you left. Please note that when you exit the program or choose New User,
you will have to begin at Level 1 when you return to the Drill Activity.

When you have completed this activity, click on Main Menu or Subject Menu.
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7. Finishing Up

Exiting the Program
You may exit the program by selecting EXIT from the MAIN MENU or by
pressing the <ESC> key. You will be given the option to exit immediately or
return to the Sign-In screen.

On-Line Help
At any time when the program is running, on-line help is available by pressing
<F1>. A Help dialogue box will appear with the chapter headings of this User's
Guide. By clicking on any chapter, the subheadings of that chapter will appear.
By clicking on any subheading or any word that is written in green, the text of
that subheading or term will appear. This On-Line Help performs all functions
similar to any Microsoft Help file.

For additional function-key commands and other mouse and keyboard
commands, see Appendix C.
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8.  Academic Version
Introduction
Welcome to NOTHIN' BUT THE FACTS Pre-Algebra Skills (NBTF)— Academic
Version!  The NBTF-Academic Version consists of the NBTF Program (to be
used by the students) and the NBTF Student Management Program (to be used
by the teachers or their assistants).  The programs are to used in tandem so that
the performance of each student can easily be recorded and tracked.  The
purpose of this NBTF Academic Version is to enable teacher time to be spent
more efficiently instructing students and student time be spent learning basic
skills.

This Academic Version can be used in a variety of computing situations:

ONE COMPUTER, ONE CLASS
Load the program on the one computer, create the class, enroll the students.
Additionally, if you have students working in pairs, create a special class and
enroll students as pairs (i.e. Bob & Mike). Or you may want to create special
classes for teams formed for competition or more efficient record keeping. All
records can be downloaded daily and uploaded to another computer with NBTF
Academic Version already loaded.

TWO OR MORE COMPUTERS, ONE CLASS (LAB PACK)
Load the program on all computers. Carefully determine which students will be
working on each computer. Caution, NBTF cannot keep one set of records for
any student who works on more than one computer--unless the computers are
networked! Therefore number the computers and assign students to a number.
On each computer, create the class and enroll the students who will be using
that computer. All records can be downloaded daily and uploaded to another
computer with NBTF Academic Version already loaded.

ONE COMPUTER, MORE THAN ONE CLASS
Load the program, create the classes, enroll the students to their prospective
class. Records for each class can be downloaded daily and uploaded to another
computer with NBTF Academic Version already loaded.

TWO OR MORE COMPUTERS, MORE THAN ONE CLASS:
Load the program on all computers. Each teacher needs to determine which
students will be working on each computer. Then, each teacher on each
computer needs to create the class and enroll those students that will be working
on that computer. Caution, NBTF cannot keep one set of records for any student
who works on more than one computer--unless the computers are networked!
Therefore number the computers and assign students to a number. All records
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can be downloaded daily from each computer and by class and can be uploaded
to another computer with NBTF Academic Version already loaded.
(Alternative): If the situation requires a student to work on a computer different
from the one normally assigned to him, enroll him on the new computer. Then at
the end of the day, print out his session report and keep in his files.

Getting Started

LOADING THE PROGRAM
Insert the NBTF Floppy into your Floppy Disk Drive and from the Program/File
manager in 3.x,or the start button in Win95, run SETUP.EXE.  Follow the
directions as instructed.

After the introduction music, the Academic menu will ask you to enter a course
and student(s) before running the program.  First, enter your unique password
and confirm (use the tab key) and then enter.

IMPORTANT:  After the initial enrollment, you may gain access to the student
management program by double-clicking on Student-Management from the
IEPMath group window, or from the sign-in screen press F10 (optional button
may be shown on bottom of screen).

CREATING CLASSES
1. Click on File (upper left-hand corner)
2. From the File drop-down menu, click New.
3. Type in a name for the class or group to be created (i.e. Room T-4 or Red
Group)
4. Press <Tab> to  move cursor from one field to another.
5. Type in the name of the instructor.
6. If everything was entered correctly, click Save; if not click Cancel.

OPENING A CLASS (Displaying a Class's Roster)
1. Click on File (upper left-hand corner)
2. From the File drop-down menu, click Open
3. Click on the class to be "opened.".

ENROLLING STUDENTS
1. From the Student Management screen, click on Enrollment.
2. From the Enrollment drop-down menu, click Add.
3. Type in a number; you may use up to nine digits. (most schools simply start
with 0001 and continue from there) No number can be repeated, and if a number
has been previously used, a dialogue box will state that "student numbers need
to be unique". Choose another number. It may be a good idea to keep a "last
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number used" note nearby for future student enrolling.  Nine digits also work well
for social security numbers.

4. Press <Tab> to move the cursor to the First Name, Last Name, and  box
preceding Enable Password. A password is optional and can be left blank. If a
password is to be used--it can be added later, click on the box preceding Enable
Password. Then type in the student's password. An enabled password requires
that the password be used for that student before he/she enters the program.

5.  If everything was entered correctly, click on Enroll; if not click Cancel and
begin again.

CORRECTING ERRORS (Editing)
1. Open the class and click on the student whose information requires editing.
2. Click on Enrollment (second from upper-left corner).
3. From the Enrollment drop-down menu, click Edit.
4. Use the mouse to click and make changes and editing.
5. When finished, click Save.

Reporting

DAILY SESSION REPORTING (Displayed on Detailed Information Screen)
NBTF keeps precise session reports for each and every activity that a student
performs within the program. You may choose a Daily Report for any day for
which the student worked from the day of the student's enrollment. To access
the reports:

1. From the Student Management screen, click on the name of the selected
student--it will be highlighted.

2. Click on View and then Detailed Information(at top, third from upper-left
corner). [Shortcut – Double click on the student’s name.]

3. A report for that student for that day will appear. If the student did not work in
the program that day, it will indicate that there is nothing to report.

4. The days in which the student used the program are in red. A maroon color
indicates a selected report, and blue is a date selected with no report available.
To change to a previous month, click the left arrow at the top of the calendar; to
change to the following month, click the right arrow at the top of the calendar. To
view a student's report for any day for which he/she worked, click on that day on
the calendar (in red).
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5. When the calendar appears, it must disappear before printing or returning to
the Main Menu. It will disappear only when one of its dates is clicked.

For the activities, the time is given in minutes and seconds. The time within the
Summary box is given in hours and minutes. If a student logs out, and then logs
back in, a second session report will be provided for that day. To print any
report, click on Print at the bottom of the screen. To return to the Student
Management screen, click on Done.

USING THE REPORTS
Depending upon the learning situation, the reports can be used in a variety of
ways. It is suggested that students be given directions or assignments as to
which parts of the program should be worked. For example, students should
begin by spending time reviewing skills in which they are proficient to reinforce
their competency.  Once an entire subject has been mastered, then users should
select the Drill activity for that subject and skill level.

Students should end up each session within the Drill Activity. It is the level
attained within the Drill Activity that gives a true scorecard of the student's
competency in the basic facts. This scorecard can be easily displayed by the
Quick Access reports displayed on the Student Management screen when each
student's name is clicked.

Write objectives for the class in your lesson plans and specific behavioral
objectives in each student's educational plan by stating:

• In the Review Activity, the student(s), by a certain date, will have
accumulated "x" hours in the learning  of a certain subject.

• In the Practice Activity, the student(s), by a certain date, will answer 24
problems of a certain type correctly in "x" minutes, or

• In the Drill Activity, the student(s), by a certain date, will obtain a certain level
(see Appendix C of User's Guide), by answering with a 100% accuracy
problems of a certain type.
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Printing

PRINTING CLASS DAILY REPORTS
You may have printed your class's roster that includes a summarized Daily
Report for each student. For each student, it will list the lowest scores and date
within the Drill Activity ,and the highest level attained.
To print a Class Daily Report, from the Student Management screen,  choose a
subject (at top),  click on File, and from the File drop-down menu, click on Print.
Then verify that your printer is on-line, and select current subject, all subjects or
roster.

Note: The students may be sorted by name, ID number, and by ascending
order.  The sort is available under View (3rd on the top menu).

PRINTING STUDENT DAILY SESSION REPORTS
From the Student Management screen, by clicking on a student and then
clicking Detailed Information at the top of the screen, you will bring up that
student's records for any day since his/her enrollment. For any report displayed,
if you wish to print it, click on Print.

Deleting

REMOVING STUDENTS FROM A CLASS OR GROUP ROSTER
1. From the Student Management screen, click on the name of the selected
student.
2. Click on Enrollment (top, second from upper-left corner).
3. From the Enrollment drop-down menu, click on Remove.
4. Confirm that you wish to delete by clicking on Yes.
Please note that when you remove a student that his/her records are
permanently removed from NBTF. Before removing, you may wish to print a
report of his/her records.
Also note, there is no way to transfer a students records from one class or group
to another. To do this, you may want to re-enroll him/her in the new group or
class by using a middle initial or changing to a nickname; he thus will have two
sets of records--one for each class or group.

REMOVING A CLASS OR GROUP
1. Click on File (upper-left corner).
2. From the File drop-down menu, click on Delete...
3. Click on class you wish to delete; or you may choose to delete all the classes.
4. Click Delete.
Warning!! By deleting any class, you are deleting all student data for students
within the class. Please backup the data on a diskette before deleting!
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OPTIONS

The Student Management Button will be shown at the bottom of the Sign-In
screen if “show” is checked.  If  “show” is left unchecked, it can be accessed by
pushing the F10 key.  The button may be turned on or off from the Options menu
in the Student Management program.

Also, the Program Password may be enabled or changed from the Options menu
in the Student Management Program.
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Appendix A: The Quick Tours
The following are three tours that when followed will provide a glimpse at each of
the three activities of this program. To take a tour, simply follow the directions
under the column heading What To Do.

Tour One (To the Review Activity)     F1--On Line Help

STOPS WHAT TO DO
1. The Sign-In Screen Type in your Name; then type <Enter>.
2. The Main Menu Screen Click on the Activity or type the first letter of that

activity: Review, Practice, or Drill. (For Tour One,
we'll choose Review)

3. The Subject Menu Screen Note that when you pass the cursor over the
buttons (the skill names), the buttons are
highlighted. Click on the algebraic skill that you
wish to review. (For Tour One, we'll choose
Absolute Values.)

4. The Review Activity Screen 1. Click on Examples to see the methods of
solution and examples.
2. Work out the first problem from the
Question Box.
3. Use the mouse to click on the correct answer in
the Answer Box (do not release), drag the
number (move the mouse) to the problem's
answer space, and drop (release). If you were
correct, the number will stay; if you were in-
correct, the number returns to its original location.
4. Continue clicking, dragging, and
dropping until all the problems are
answered correctly.
5. If you wish to generate another set,
click on More.
6. When you are finished, click on Subject Menu
or Main Menu.
 (To return for the next tour, we'll choose Main
Menu)

5. The Main Menu Screen For Tour One, this will END OUR TOUR.
Thank-you; we recommend Tour Two!



29

Tour Two (To the Practice Activity) F1--On Line Help

STOPS WHAT TO DO
1. The Sign-In Screen Type in your Name; then type <Enter>.
2. The Main Menu Screen Click on the Activity or type the first letter of that

activity: Review, Practice, or Drill. (For Tour Two,
we'll choose Practice.)

3. The Subject Menu Screen Note that when you pass the cursor over the
buttons (the skill names), the buttons are
highlighted. Click on the algebraic skill that you
wish to review. (For Tour Two, we'll choose
Addition of Integers--Same Signs.)

4. The Practice Activity Screen 1. Click on Examples to see the methods of
solution and examples.
2. Type in the answer to the card displayed,
then type <Enter>. Were you right or  wrong?
3. Type <Enter> again. (Note, the last card
either is placed in the Mastered Area, or is
returned to the Unmastered Area.) Continue
answering cards until all cards are in the
Mastered Area. Note that exhibited at the bottom
of the screen is the total time taken to answer all
six correctly.
4. If you wish to generate another set, click on
More.
5. When you are finished, click on Subject Menu
or Main Menu. (To return for the next tour, we'll
choose Main Menu)

5. The Main Menu Screen For Tour Two, this will END OUR TOUR.  Thank-
you; we recommend Tour Three!
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Tour Three (To the Drill Activity) F1--On Line Help

STOPS WHAT TO DO
1. The Sign-In Screen Type in your Name; then type <Enter>.
2. The Main Menu Screen Click on the Activity or type the first letter

of that activity: Review, Practice, or Drill.
(For Tour Three, we'll choose Drill.)

3. The Subject Menu Screen Note that when you pass the cursor over
the buttons (the skill names), the buttons
are highlighted. Click on the algebraic skill
that you wish to review. (For Tour Three,
we'll choose Addition & Subtraction of
Integers.)

4. The Practice Activity Screen Read the instructions. Note the time limit
for answering all ten problems.
Type <Enter> when you are ready!

5. The Drill Problem Screen Type in the answer to the problem
presented as quickly as possible. (If you
make a mistake, use the <Backspace>
key before entering.) Then type <Enter>.
Continue answering problems until you
have answered 10.

6. The Drill Problem Set Note the results of your performance for
Summary Screen ten problems. For
problems where you erred, note your
answer and the correct answer. When you
are finished, click on Subject Menu or
Main Menu. (To return, we'll choose Main
Menu).

5. The Main Menu Screen For Tour Three, this will END OUR TOUR.
To exit,  choose New User or type <Esc>.
Thank you and good luck with NOTHIN'
BUT THE FACTS!
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Appendix B: Integer Algebra Skill
Areas With Examples
The following, by use of examples, is a glimpse of the content of Pre-Algebra
Skills v2.1

Opposites & Absolute Values

Absolute Value:
2 2

2 2

=
− =

                   
− − = −
− = −

5 5

18 18

Identify:

        
( )

− = −
− − =
− =

( )
( )
5 5

7 7

0 0

             

( )

( )
( )
12 12

8 8

0 0

=
− = −

=

Combinations

            ( )
− − = −
− − =

3 3

12 12
   

− = −
− =
( )9 9

11 11

Algebraic Addition of Integers

Same Signs

   
( ) ( )− + − = −

+ =
5 7 12

9 22 31
                     

− + − = −
+ =

4 5 9
9 14

( )
(5) ( )

Different Signs:
5 11 6+ − = −( )   ( − + = −18 9 9)
− + =8 12 4  ( ) ( )− + = −12 4 8

Three Integers:
(-5) + (-3) + (-8)  =  -16 -7 + 5 + 9 = 7
(-6) + 4 + (-7) = -9  9 + (-8) + 4 = 5
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Algebraic Subtraction of Integers

Two Integers:
-4 - 6 = -10  (-4) - (-6) = 2
12 - 16 = -4  5 - (8) = -3

Three Integers:
-3 - (8) - (-6) =  -5 -8 + (-3) - 5 =  -16
12 - (-6) + 8 = 26 9 - 6 - 7 = -4

Using Parenthesis:
-5 + (-3 +5) = -3 11 + (11 - 15) = 7
3 - (-5 - 7) = 15 -2 - (12 - 4) = -10

Multiplication, Division & Combined Operations

Two Integers:
(-13)(12) = -156 − ÷ − =132 11 12( )
(9)(6) = 54 84 7 12÷ − = −( )

3 or More:
(-2)(-5)(7) = 70 (3)(-3)(-1)(-1)(-2) = 18
(-4)(3)(4)(5) = - 240 (-1) (-1) (-1) (-1) (-1) = -1

Combined Operations:
-5 + 3(-6) = -23 22 - 9(-14) = 148
12 + (-7)(-9) = 75 -15 - 3•18 = -69
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Appendix C: Interface Commands

MOUSE COMMAND KEYBOARD
COMMAND

MEANING

(None) F1 Help: Assistance and instructions
available by search.

Click on Main Menu F3 Main Menu: Advances the program to
the screen where you may choose an
activity button.

Click on Subject F4 Subject Menu: Advances the program
to the screen where you may choose
the algebra skill you wish to work on.

Click on New F5 New User Screen: Advances the User
button program to the screen where
you sign in.

(None) F8 Sound: Turns the sound ON or OFF.
(None) F9 Version: Provides information of this

version of NOTHIN' BUT THE FACTS
Click on Examples E Examples: Displays methods of button

solution & a complete set of
examples

Click on Review R Review Activity: Advances the
program to the Review Activity from the
Main Menu.

Click on Practice P Practice Activity:  Advance the button
program to the Practice Activity

from the Main Menu
Click on Drill D Drill Activity:  Advances the

button program to the Drill Activity from
the Main Menu
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LEGAL STATEMENTS
Before using this product, NOTHIN’ BUT THE FACTS  Pre-Algebra Skills v2.1, please read the Software License
Agreement below. In summary, it specifies that this program is protected under US copyright law.  It can only be copied for use
as a backup copy.  If more than one computer is to be used for more than one user, you must purchase a separate product for
each computer.  This includes users and computers on a network.

Please fill out and return the enclosed Registration  Card..   Filling out and sending in  this card initiates your warranty and
enables us to inform you about updates, revisions, and other IEPMath  products.

DISK WARRANTY: IEPMath warrants the 3 1/2 inch floppy disk on which this software program is recorded to be free from
defects in materials and faulty workmanship for a period of  60 days from the date the software was purchased.  This applies
to the original purchaser only. If any defects should occur within this period, please contact IEPMATH and we will replace the
disk without charge.  After the 60 day period, we will replace the disk at a reduced (from the purchase price) charge.

LIMITED WARRANTY: This program is provided “as is” without warranty of any kind, either expressed or implied.  This
includes but is not limited to the implied warranties of merchantability and fitness for a particular purpose.  The entire risk as to
the quality and performance of the program and that of the user is assumed solely by the original purchaser.  In no event shall
IEPMATH  be liable for any direct, incidental, or consequential damages arising from the use of this software program.

DISCLAIMER: IEPMath  extends no actual or implied endorsements of the programs it distributes and publishes.  These
programs may not adequately address a purchaser’s particular need or intended use, and  IEPMATH  does not warrant or
represent their suitability for such purposes.  IEPMATH is not engaged in the delivery of instruction, and its programs should
not be relied upon as substitutes for professional and/or accredited educational offerings.

SOFTWARE LICENSE AGREEMENT:   By using the enclosed program NOTHIN’ BUT THE FACTS, Pre-Algebra Skills
v2.1, you, the original purchaser of this program, accept all of the following terms.  If these terms are not accepted, please
return the entire package, unused, to the original place of purchase according to its specific Return Policy.
Terms:
• IEPMath  remains the sole owner of this program.  IEPMATH grants to you and you accept a non-exclusive license for the

use of this program.
• You may not change, add to, or delete any portion(s) of the source code of this program, nor may you create derivative

works from it.
• You may not remove or conceal any trademark or copyright marks or notices in any copy of the software, manual, or other

documentation.
• You may use this program on only one computer at a time. Only copies for backup protection are allowed.  You may not

rent, lease, or otherwise distribute copies of the program’s software, manual, or other documentation to anyone else.  You
may not transfer this program electronically from one computer to another, including computers in a network.

• This license agreement is in effect until all components of the program are either returned to its original place of
purchase, or until they are destroyed.

• IEPMATH may terminate this agreement at anytime without notice if you breach any of the terms.
• In no event shall IEPMATH be liable for any direct, incidental, or consequential damages arising from the use of this

software program.

NOTHIN’ BUT THE FACTS (software and related documentation) was developed at private expense. No portion of this
software is in the public domain and in all respects is proprietary to IEPMATH.  The manufacturer is IEPMath, PO Box 54,
Lytle Creek, CA., 92358, USA

Trademarks

NOTHIN’ BUT THE FACTS  is a trademark of IEPMath and is being reviewed for registered trademark status by the US
Patent and Trademark Office.  Copyright ©1996 IEPMath.

Macromedia and Authorware are registered trademarks of Macromedia, Inc. Windows is a trademark of  Microsoft Corporation.
All other trademarks or registered trademarks are the property of their respective owners.  The use of these trademarks is not
intended to indicate a connection with, endorsement of, or sponsorship by these companies.

IEPMATH, PO  Box 54, Lytle Creek, CA. 92358, USA
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